
About Agile Help
Agile Help has been carefully designed to work in several ways:

to give fast answers to specific questions such as "how do I?" or "what is this for?";
to allow you to browse through topics for useful tidbits;
to explain why Agile is a better HTML editor, and how to get the most from it.

There are several ways to access help:
the Help Topics command on the Help menu takes you to the topics summary;
the F1 function key accesses help about the current context, such as a currently open dialog.

Four hints to help you get the best out of Agile Help:
click on a picture where you see a 

 cursor to discover more about different parts of the picture;
clicking on Highlighted Text Like This will take you to information on a new topic;
whereas Text Shown Like This shows information in a little popup window;
use the 

 and 
 buttons to browse back and forth through the topics in the current section.

I hope you feel all the effort has been well spent. Thanks for trying, or especially for buying, Agile.

Mark Hughes
Compware

Copyright © Compware 1996. All Rights Reserved.



Anchors have their own colour setting



The text of an Agile document uses syntax colouring to make your HTML easier to read, and to highlight 
errors or use of tags which are not supported by your target HTML standard or browsers.



Anatomy - document window



Mistyped and disabled HTML tags are highlighted in red as soon as you type them



Status Bar keylock indicators:

Show CAP, NUM or SCRL to indicate lock of the Caps Lock, Num Lock and Scroll Lock keys respectively.



The main menu 



This shows the contents of the Quick menu.

Note that the right hand side of the menu shows the keyboard shortcuts provided for frequently used 
commands.



Anatomy - scroll bar



The status bar shows useful messages including descriptions of menu items and also the state of Caps 
Lock, Num Lock and Scroll Lock keys.



Status Bar message area:

Displays status information and helpful hints, including summaries of menu commands and help about 
HTML attribute values when the Context menu is active.



Table and form tags are shown in a single colour so that tables and forms stand out from the rest of the 
document



Appendices
This section contains additional information not related to Agile functionality or modes of use:

obtaining a license
installing a license key
reporting a problem
additional information files



Additional Information Files (Appendices)
Additional information is included included in the README.TXT file supplied with Agile. You should read it
to obtain the most up-to-date information about the content of the Agile HTML Editor package.

The following additional sources of information are included with the Agile HTML Editor package, but 
others not listed here may also have been added, so please refer to README.TXT for a complete list:

README.TXT Read for the latest information and for details of 
other .TXT files.

LICENSE.TXT Describes the terms under which you may use 
the software.

WHATSNEW.T
XT

Describes the new features in this and previous 
versions.

ORDER.TXT Includes a ready to use form for registering the 
software.

ERRATA.TXT Describes late changes or additions to 
documentation.

PROBLEMS.T
XT

Describes known problems, incompatibilities and
workarounds.

NOTE:

If clicking on the above file names fails to find the appropriate file, you may have deleted the file from your
Agile directory, or more likely have changed the current directory while running Agile (by loading or saving
a file for example). Restarting Agile should fix the latter problem, but if the files are not contained in your 
Agile directory, you will obviously have to locate them from a backup or from the distribution disk.



Installing A License Key (Appendices)
When you have obtained a license, you must install your license key using the License Installation dialog. 
If a valid license key is not installed, this dialog is displayed automatically when Agile starts up. You can 
also open the dialog using the Install License Key command on the Help menu.

Use the dialog to input the key manually, or to supply the name and location of the license key file. Then 
press the Install button which will attempt to install and validate the license key.

After installing the key, you can check the status of your license using the License Details command on 
the Help menu.



Obtaining A License (Appendices)
Agile uses a license key to control access to its features. Some features will only work when a valid 
license key has been installed. This is because Agile is protected by copyright and should only be used in 
accordance with terms of the Agile license described in LICENSE.TXT (see additional information files).

You must register in order to obtain a license to use Agile, or you may use an evaluation key for a limited 
period, as described in the Agile license file LICENSE.TXT (see additional information files). Note that an 
evaluation key may not give access to all Agile's features, and may be valid for a limited period.

How To Register

Registering involves purchasing a license to use the software, which includes supply of a license key. Full
details of how to register, and a registration form are included in the file ORDER.TXT (see additional 
information files).

How To Obtain An Evaluation License Key

We don't promise to make evaluation licenses available but we do want people to try Agile because we 
feel that once you've tried it you'll be so impressed that you'll want to do the decent thing and register it. 
The file README.TXT (see additional information files) contains the latest information on how to obtain 
an evaluation license key.

Don't forget though, evaluation means just that. Once you have tried Agile out you must make a decision 
to register, or stop using it.

If you don't register but continue using Agile beyond the terms of our evaluation license, you are breaking 
the law, and more importantly, depriving me of some hard earned cash. If only you knew how much time 
and effort I have put into this program, you'd surely register.



Reporting A Problem (Appendices)
If you have a problem using this software we will always try to help solve it. We recommend that you carry
out the following steps before contacting us about a problem. This will help us to help you.
      
1
.

Check the README.TXT file and make sure that your system meets the 
hardware and software requirements.

2
.

Check the PROBLEMS.TXT file to see if the problem is already known 
and if so, to see if a suitable workaround is available.

3
.

Attempt to determine if the problem is only related to Agile, or if it seems 
only to occur when another particular program is running.

4
.

Attempt to identify any particular circumstances which are associated with 
the problem occurring, or which alleviate the problem.

5
.

Attempt to identify a reliable and repeatable way of causing the problem.

Please bear in mind that we will find it difficult to help if we can't replicate the problem ourselves or if you 
omit some information that is in fact crucial to us understanding what is happening or which is a key 
contributory factor.

To access the README.TXT and PROBLEMS.TXT, see the section on additional information files.

Describing The Problem

When you report a problem, please

give a precise description of the problem;
include the exact text of any error messages;
say if the problem occurs randomly or is repeatable;
provide instructions on how to replicate it, or any circumstances that contribute to it or which 

prevent it; and
include any other information which you feel may be relevant.

Report Problem Dialog

To help you provide this information, Agile incorporates a Report Problem command on the Help menu. 
This command opens the report problem dialog which prompts you for the information we need and 
automatically gathers additional background information that will help us identify the cause.

The dialog will generate a text file including the details filled in plus the additional background information.

After generating the report file, you can email it or print it out and send it to us, or use it to help answer 
questions we have when you contact us.



Accept the changed settings but don't close the dialog.



Cancel the dialog and take no action.
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Hold down the Ctrl key and press C



Hold down the Ctrl key and press R



Hold down the Ctrl key and press U



About Agile
The About box shows miscellaneous information including:

the product version;
the licensed owner's name, decoded from the license key;
on-line contact points for registration and support;
copyright notice.



Attribute Editing Dialogs
There are several ways to edit the attributes of an HTML tag. See editing tag attributes for more details.

For some attributes, Agile provides a dialog which is used to modify or remove an attribute. This dialog 
will be shown for such an attribute if you:

Agile uses its built in HTML Awareness to combat this problem by helping you identify which attributes are
available, what they mean, and what values they accept. At the centre of this is the Context menu, which 
lists the attributes available for a chosen tag.

1) right-click on the tag using the mouse to open the Context menu;
2) choose the menu item for the tag you wish to edit. (Note that as you highlight different items on the 

context menu, the status bar will change to give you a description of each attribute, and where 
appropriate, hints about the values it accepts.)

The dialog shown will vary slightly depending on the type of value appropriate to the attribute. In some 
cases, a "Browse" type button will be included to help you locate a file, but its name will reflect the type of 
file that is appropriate, and the browse dialog which it uses will also be customised to list appropriate 
kinds of file (such as HTML, images, sounds and so on).

The example dialogs below show the different dialogs for selected attributes from the following image tag:

          <IMG ALT="Map of Europe" SRC="..\..\Html\Graphics\Ec.bmp" ALIGN=TOP>

 Click on the picture where you see this cursor.

 Click on the picture where you see this cursor.



 Click on the picture where you see this cursor.

 Click on the picture where you see this cursor.



The HTML name of the attribute.



The current value of the attribute, which you can edit directly.



This descriptive name of the attribute being edited.



Opens a dialog to browse animation files. Browsing begins at the location specified by the current 
attribute value, if present.

Initially, the dialog will show all animation files. Files can also be listed by animation type, or you can 
choose to list all files.



Opens a dialog to browse image files. Browsing begins at the location specified by the current attribute 
value, if present.

Initially, the dialog will show all image files. Files can also be listed by image type, or you can choose to 
list all files.



Opens a dialog to browse HTML files. Browsing begins at the location specified by the current attribute 
value, if present.

Initially, the dialog will show all HTML files. Files can also be listed by HTML type, or you can choose to 
list all files.



Element Attributes Dialog
This dialog is a quick way of viewing and editing the attributes of an HTML element. Open it by right-
clicking the mouse on an HTML tag to open the Context menu and then choosing the Properties 
command.

To insert an attribute into a tag, or remove it, or or change its value:
1) select the attribute entry in the list box;
2) click on the  button which appears at the right hand edge;

3) use the pop-up menu or attribute editing dialog to enter a value or remove the attribute.

The list always shows all attributes supported by the HTML element being edited, but those which are not 
present in the tag will have no value listed.

The following example shows how the list would look for the following image tag:

          <IMG ALT="Map of Europe" SRC="..\..\Html\Graphics\Ec.bmp" ALIGN=TOP>

 Click on the picture where you see this cursor.



Click on the  button to set or modify an attribute value, or to remove the attribute from a tag.

The method of editing will depend on the type of the attribute. In some cases it is simply a matter of 
selecting an item from a pop-up menu. For other attributes, a dialog will open showing the current value, 
which can be edited. This attribute editing dialog will vary depending on the type of the attribute.

The edit attribute button always appears on the right hand edge of the list item for the selected attribute.



This region of the attribute list item shows the descriptive name of the attribute. The descriptive name 
show will vary depending on the settings on the General Tab of the Options dialog.

Each list item shows the HTML Name, the descriptive name and the value, if any, of an element attribute.



This portion of the attribute list item shows the HTML name of the attribute. You can hide the HTML 
names by unchecking "Show HTML Names" underneath the list box.

Each list item shows the HTML Name, the descriptive name and the value, if any, of an element attribute.



This area of the attribute list item shows the value of each attribute, if any.

Each list item shows the HTML Name, the descriptive name and the value, if any, of an element attribute.



This is a pop-up menu which lets you change the value of an alignment type attribute. The current setting 
is indicated by a check mark. Choosing "Remove" will remove the attribute from the tag, completely.



Dialog - Element Attributes - menu remove



Uncheck this to hide the HTML Names displayed in the leftmost column of the list box.



Directory chooser - click to reveal a tree listing of drives and directories.



Create new directory.



Dialog - File / Open / Safe / Save As - directory selection



Move up to the parent directory.



Listing of files in the chosen directory which match the "Files of type" selection below.



The name of the currently selected file.



Selects the type of files listed from the current directory.



Click to open (or save to) the named file.



Toggle the list of files between a concise list and full details of each file, including size, date and so on.



File Open / Save As Dialog
This dialog is used to specify the name and location of a file. A similar dialog is displayed for the Open, 
and Save As commands on the File menu

 Click on the picture where you see this cursor.



License Details Dialog
This dialog shows the status of the Agile license.

This includes the product, licensee, license reference number and if appropriate, the expiry date of an 
evaluation license.



License Installation Dialog
Installs a license key to enable Agile functions covered by the license, for the period of validity of the 
license. If you have registered Agile, you will receive a key that will enable Agile functions indefinitely.

See obtaining a license and    installing a license key.

 Click on the picture where you see this cursor.



Close the dialog without installing a license.



Attempt to install a key from the specified file or manually input text.



Indicate the file containing a license key, or type the key in manually.

If your key is in a file, usually called 'license.cde' you can use the Browse    button to specify the file.

If you enter a manual key, note that keys are not case sensitive.



The product identity which must be matched by the key for the key to be valid.



Current status of your product license.



Appearance Tab - Options Dialog
The Appearance Tab lets you customise the document font and syntax colouring.

To open the Options dialog, use the Options command on the File menu.

 Click on the picture where you see this cursor.



Check to enable syntax colouring.



Choose the face and size of the document font.



Choose a from this list to change the colour of the selected item.



This list shows the current colour setting for each item.

The items are chosen to let you pick out:
document text
the anchor tag
groups of similar tags
disabled tags
errors (unrecognised tags)



This window is updated as you change settings on the dialog.

It contains a sample HTML document which contains a range of different HTML elements, including 
errors, so that you can see immediately the effect of changes to document font and item colouring.



General Tab - Options Dialog
The General tab is used to configure several features:

the HTML browser used for previewing (currently Internet Explorer v1, v2 or Netscape v1, v2)
the content of the Context menu, allowing you to hide or disable advanced or little used HTML 

attributes
customised naming of HTML elements and attributes in menus and dialogs
upper or lower case HTML tags, when inserted using Agile commands

To open the Options dialog, use the Options command on the File menu.

 Click on the picture where you see this cursor.



Show, hide or disable advanced or little used attributes on the Context menu:

to hide the attributes, uncheck "Include Advanced..."
to show them greyed, check both boxes
to enable all attributes on the menu, check only "Include Advanced..."



Check to make Agile commands insert tag and attribute names in lower case.



The terminology used for HTML tag and attribute names on Agile menus and dialogs:

Setting Meaning Example for <A> and its 
HREF tag

Descriptive Simple descriptive name Hypertext Link / Destination 
URI

HTML 
Terminology

Official (HTML specification) 
terminology

Anchor / Hyperlink URI

HTML Tags Raw tag and attribute names 
(for the brave).

A / HREF



Choose a browser from the list for use with Agile's HTML Previewing feature.

The first time you select a browser, you may also need to indicate the application path. This is easily done
using the Browse button.

HTML Previewing is made easy in Agile by:

automatically starting the browser when first needed
reusing the browser once running
scrolling the browser to the portion of the document being edited
providing a Toolbar button and a keyboard shortcut [Ctrl-R] for instant updates during editing



HTML Support Tab - Options Dialog
The HTML Support Tab lets you target your pages to a particular HTML standard, browser, or group of 
standards/browsers.

You can choose to enable support for all tags belonging to one or more groups (see the left hand "Enable 
All Tags For" list in the dialog below). Alternatively, you can enable support for tags which are common to 
a set of groups (see the right hand "Plus Tags Common To" list). 

Of course you can use a combination of "all tags" and "common tags" settings. The decision is yours. 
After all, they are your Web pages!

To open the Options dialog, use the Options command on the File menu.

 Click on the picture where you see this cursor.



Add an item to the above list.



This list shows the enabled HTML element support. The elements are grouped by HTML standard and 
Web browser.

Agile will support all tags in all groups listed here.



Remove an item from the above list.



Add an item to the above list.



This list shows the enabled HTML element support. The elements are grouped by HTML standard and 
Web browser.

Agile will support all tags which are common to all the groups listed here.



Remove an item from the above list.



Shows the Appearance Tab on the Options dialog.



Shows the General Tab on the Options dialog.



Shows the HTML Support Tab on the Options dialog.



Report Problem Dialog
This dialog is provided to help you report a problem.

Fill it out as fully as you can, and this will help us to help you.

After filling it out, press Save Report to generate a text file which you can send to us for assistance.

 Click on the picture where you see this cursor.



The postal address where we can contact you.



A description of the problem you have and how to replicate it.

Please click on Hints for a checklist of things which you could include in the description.



Your first name.



Displays a checklist of things to include in the problem description.



Your last name (family name).



Detail level for the automatically generated sections of the report:
Concise: a short summary of the most limited information about your system. May be 

inadequate.
Standard: summary information plus the contents of some system configuration files. Usually 

adequate.
Detailed: extended information which may result in quite a large report file. Rarely required.

Please inspect the generated report before sending it.



Generate a problem report text file containing information from the dialog and additional information 
detected automatically.



Your telephone, fax and email details as appropriate.



Your title: Mr, Mrs, Ms, Dr etc.



Hold down the mouse button on some selected text and move the mouse until the cursor changes shape.



Example Jump
Like this!

Now click on the button labelled Back above.



shows information in a little popup window



HTML stands for Hypertext Markup Language and is the stuff from which World Wide Web pages are 
made of.

If you want to create Web pages, you'll need to produce files containing HTML using an editor like Agile, 
or using other tools that convert your desired layout into HTML automatically. Manipulating the HTML 
directly is more involved, but gives you greater control over the layout and speed of loading of pages.



An HTML Attribute is used within an HTML Tag to provide additional information on how the tag is to be 
interpreted.

For example, the start tag for the following anchor element contains an "HREF" attribute, which indicates 
the destination for a Hypertext Link.

<A HREF="http://webzone1.co.uk/www/compware/">This is a link</A>

Different HTML Elements support different attributes within their tags.



An HTML element (often referred to as an HTML Tag) is a programmatic unit of HTML which instructs an 
HTML viewer or browser on the content or layout of an HTML document.

Some elements describe structure, others provide links to other documents or parts of a document, and 
other elements control the layout or appearance of the text.



An HTML Tag is a syntactic component of HTML which starts with '<' and ends in '>'.

For example <P> is the tag used to indicate the start of an HTML paragraph element.

HTML Elements have start tags and frequently also have end tags, although the latter may not be valid or
may be optional for some element types.



Show help about this dialog.



Highlights
See the items listed below and click on the picture for some of Agile's highlights.

HTML Awareness Lets you target multiple browsers and use the latest HTML features without 
spending hours buried in HTML standards.

Syntax Colouring Makes any HTML readable and highlights errors as you type.

Inserting Tags Accelerated using structured menus, shortcuts and insertion around the 
selection.

Editing Tag Attributes Made easy using a context sensitive menu, status bar hints and helper dialogs.

Inserting URLs Insert URLs from web pages, explorer directory listings or emails.

Superior Previewing Instant updates show the region you are working on using Internet Explorer and 
Netscape Navigator.

User Interface Fully configurable by you, and automatically based on chosen HTML features.

A Desire To 
Improve...

We want you to help us keep improving Agile.

Example Screen Shot



 Click on the picture where you see this cursor.

HTML Awareness

Built in understanding of HTML lets you target single or multiple browsers and removes the need for you 
to know the standards in order to make use of state-of-the art features.

Agile has, built into it, full details of the tags and their attributes for the main official HTML standards and 
popular Web browsers. Configurable HTML support means that you can target a single browser (or 
standard), or decide to use features common to a number of browsers (or standards).

Your chosen set of HTML features is used by Agile to customise its syntax colouring, menu structure, 
dialogs and status bar hints, removing the need for you to remember which tag or attribute is supported 
by which browser. Unsupported tags will be highlighted in red as you type, and the menus will only show 
commands to insert the tags you want to use.

When editing tag attributes, the context menu and element attributes dialog show only attributes (and 
attribute values) appropriate to your chosen HTML configuration.

Unmatched Syntax Colouring



Agile shows different tags, 
groups of tags, and other 
features in different colours. 
Colouring is done as you 
type, ensuring that your 
HTML is always easy to 
read, and highlighting 
mistyped tag names 
immediately

You can change the colours 
used and choose a different 
font using the Appearance 
Options.

 Click on the picture where
you see this cursor.

Inserting Tags

You'll find the most frequently used tags on the Quick menu, with accelerator keys for instant access. For 
example, to insert a URL you can type Ctrl+L.

When a pair of tags is inserted such as <A> and </A> when you insert an Anchor, note that the tags are 
inserted around any selected text. This makes it easy to create Hypertext Links or mark text in different 
styles. For example, you can mark text to be rendered as bold italics by selecting it and then typing 
Ctrl+B, Ctrl+I.

If there isn't any text selected, notice that after inserting a pair of tags, the cursor is placed between them. 
This is useful because you can set text styles as you type with the minimum of cursor movement. For 
example, in the middle of typing a sentence you can type Ctrl+I to change to italics, and then continue 
typing without pausing.

This attention to detail makes Agile much easier to use.

Other tags are located on the Structure, Formatting and Advanced menus which are organised logically to
make things easy to find. See menus for more information.

Editing Tag Attributes

Editing tag attributes is made easy without you needing to remember all the details. Agile's menus and 
dialogs change to feature only the elements and attributes supported by your chosen browser(s) and 
standard(s). Agile knows which elements are supported and which values are appropriate.



Inserting, modifying or removing tag attributes is made simple using a context menu and element 
attributes dialog. Many operations can be performed by right clicking on a tag and then choosing an item 
from a menu, without the need for additional dialogs or typing.

Agile's understanding of HTML makes light work of editing tag attributes and inserting URLs.
some attributes don't have a value, so to insert or remove one, right click on the tag and choose 

the attribute from the context menu
some attributes have a fixed set of values, so these will appear on sub-menus of the context 

menu, with the current setting checked. Changing or removing the setting is again just a matter of 
choosing the appropriate menu item.

some attributes have complex values, so Agile helps you by providing hints on the status bar and 
provides helper dialogs.

To help when editing tags which utilise a lot of attribute settings, the element attributes dialog lists all 
available attributes for the tag with their current value, if any.

Inserting URLs

Preparing Web pages means inserting a lot of URLs, so a special command has been provided to make 
this as easy as possible, and to accept URLs from a number of sources and in different formats.

The Paste URL command works for any tag which accepts a URL and inserts (or modifies) the 
appropriate attribute and translates the URL into the correct format.

URLs can be obtained:
for paths to files, by selecting the file in Windows Explorer
from Web pages, by copying the link in Internet Explorer or Netscape Navigator
from emails or other documents by copying text to the clipboard

Agile examines the inserted value and ensures that it is in the most appropriate format by:
making paths relative to the edited document when appropriate
automatic translation of Windows file paths into URL format

See the Paste URL command for details.

Superior Previewing

One of the problems of creating Web pages, even when using a supposedly WYSIWYG editor, is knowing
that your page will look as you intended when viewed on a range of Web browsers. The only sure way of 
checking your page is to view it in each browser which you intend to support.

Agile makes previewing easy to do using various versions of both Internet Explorer and Netscape 
Navigator. You can preview any document using the Refresh Preview command [Ctrl-R] on the Quick 
menu.
You can also use the  button on the Toolbar.

When you use want to preview a Web page Agile will start your browser automatically and instruct it to 
load the document which you are editing. Other editors are capable of this, but don't support all the 
following:



preview of the area being edited so that you don't have to scroll the browser widow to find what 
you are working on

fast update by reusing the browser window once running
proper display of images
multiple browser configurations, including Internet Explorer v1 and v2 and Netscape Navigator v1 

and v2
easy switching between different browsers
temporary files are tracked and guaranteed to be removed - even if your computer is accidentally 

switched off

Remember that the only way of really achieving What You See Is What You Get, is by previewing in the 
browsers you want to support.

User Interface

As explained in the Overview, a lot of effort has been invested in Agile's user interface to make sure that 
everything is easy to do, and to make it automatically reconfigure to support your chosen HTML 
standards and browser tags. In addition, Agile exploits all the best Windows user interface features, 
including:

standard Windows editor conventions for menus, accelerator keys, recently used file list and so 
on

open files by dragging them from Windows Explorer and dropping them onto Agile
multi-level undo/redo
find, find again, find and replace
context sensitive help for every dialog at the press of the F1 key
floating/dockable toolbar (resizeable and dockable to top, bottom, left or right)

We've also made features configurable to work the way you want to, rather than the way we might think is
best. Below are some of the things which you might not expect to be configurable, but may soon wonder 
how you did without:

the colours used to display different kinds of tag, mistyped tag names, disabled tags and 
document text

which browser tags are supported on menus, dialogs and so on
the terminology used for tag and attribute names on menus and dialogs
the font used for editing
whether tags are inserted in upper or lower case
which browser to preview with

A Desire To Improve...

We want to know what you think about Agile, and also want to fix any problems you may find, as quickly 
as possible.

To help you let us know what you think or report a problem, there is one extra novel feature to make this 
as easy as possible. Please use the report problem dialog to send us feedback or bug reports. It will help 
you by retaining the details you type in for future use, and by automatically collecting information about 
your system which may help us in isolating a problem.



The report problem dialog can be used to generate a report in the form of a text file which you can review 
and then send to us by post, email or fax.



A Hypertext Link is a region of a World Wide Web document which if displayed in a Web Browser, can be 
used to jump to another document or part of a document. For example, in many browsers, such links are 
displayed in highlighted underlined text, and can be clicked on using a mouse to take the browser to 
another location, anywhere on the Web.



Internet Explorer is a popular Web Browser from Microsoft Inc.



A license key is a sequence of alphabetic characters and digits, normally supplied in a file called 
license.cde but which could be supplied via email or in printed form.

Agile license keys can be read from a file or typed in manually.



Netscape Navigator is a popular Web Browser from Netscape Inc.



Close the dialog and accept the changed settings.



Overview
What Is Agile?

Agile is a text based Web page editor with a big difference (see What Makes Agile So Special?) which 
runs on Windows 95 and Windows NT. To see what Agile looks like see the example screen shot.

With Agile's unmatched syntax colouring, you get the ease of use associated with WYSIWYG but keep 
the advantages that come with creating Web pages from the bottom up. You remain in control of the 
HTML features used, but don't need to keep all the standards and browser extensions in your head. You 
won't even have to keep referring to HTML element documentation, because Agile's HTML Awareness 
does the hard work for you.

Agile makes it easy to read and author HTML which will be compliant with your chosen combinations of 
official and unofficial standards. You choose which features are supported so that you can target your 
pages at one or more standards or browsers. By building in support for HTML elements, and HTML 
attributes, Agile frees you from what would be a massive learning task.

Automatic user interface configuration (including menus, syntax colouring and tag editing) ensures that 
the user interface is always tailored to just the set of HTML features which you require, and not cluttered 
with support for features that are redundant or too new and poorly supported to make use of.

Please remember that Agile is protected by copyright and must be registered before you will be able to 
use it properly, unless you obtain an evaluation license, as described in the file README.TXT (see 
additional information files).

Please try it. If you do we think you'll buy it. 

What Makes Agile So Special?

The thing that makes Agile special is the philosophy behind it, which is simply:

to put more effort into making the software work well, and less effort into being able to list 
a huge number of features

This has involved putting a lot of effort into the user interface, and building in detailed knowledge of 
numerous HTML standards to relieve the user of as much work as possible, and reducing the level of 
knowledge of HTML that is needed to produce state-of-the-art Web pages from the bottom up.

Carefully designed user interface features such as the context menu, syntax colouring and attribute 
editing, work in a way that is both obvious and efficient, and make maximum use of the built in knowledge
of HTML.

Another goal was to make Agile configurable for the different ways in which people work. From mixing 
and matching of HTML standards and browser extensions, to choosing the colour for Anchor or Table 
tags, things are not just configurable, but easy to configure. In some cases, you'll even find that 
configuration is done for you, such as automatic user interface configuration (of menus, syntax colouring 
and tag editing) to match your chosen HTML features.

Although extra effort has been put into making things work well, the feature list for Agile is still extensive. 
Even so, you can be sure that every feature listed is a real feature, which is truly useful and not 
something hacked together quickly for the sole purpose of ticking off one more item in the feature frenzy 
wars. Agile also has several unique features of its own which make editing HTML a far easier task than it 
is with other editors.



Why do so many people still prefer plain old Notepad when editing their Web pages? It is because the 
bells and whistles and user interfaces of most HTML editors simply don't help you get the job done. If only
the Notepadders could be persuaded to give Agile a try, they would find that at last there is an editor 
which does help you get the job done.

I hope you'll agree that the above philosophy sets Agile apart from the herd of other HTML editors. Why 
not take a quick look at the Highlights to see where some of the main differences lie, and then give it a try 
for yourself.

I hope that you like what you find. I feel sure that the effort of evaluating Agile will be worthwhile and that it
will be an essential part of every HTML-head's toolbox. I wrote Agile because I wanted help with editing 
HTML. So long as I'm writing HTML, you can be sure that Agile will continue to be at the forefront of 
HTML editing tools, and will keep up to date with new standards (official and unofficial) as they emerge, 
because I need it too.

Although I'm not short of ideas for improving Agile, I place particular value on comments and suggestions 
from other, because my own ideas are inevitably coloured by my own way of working and past 
experience. You can be sure that every comment I receive will be considered seriously, so please take the
trouble to provide feedback.

Thanks, and may all your HTML be rendered as you intended,

Mark Hughes
Compware

Copyright © Compware 1996. All Rights Reserved.



Summary of Features for v1.00 beta 2 (Overview)
Features are described under the following headings:

true Windows 95 application
full featured editor
syntax colouring
HTML tag and attribute support
target your pages at chosen browsers and standards
HTML awareness exploits tag/attribute support
instant page preview using web browser
additional user interface features
works the way you want to work

True Windows 95 Application:

32-bit C++ with all the trimmings
complete Windows 95 look and feel including: drag and drop file opening, common dialogs, 

floating toolbar, tooltips, status bar, message prompts, long filenames, recent file history and so on
complete context sensitive help
written for and tested on Windows 95

Full Featured Editor:

unlimited file size
multi-level undo/redo
select and drag editing
find, replace, replace all

Syntax Colouring:

colouring is done as you type
uses different colours for different tag types (structure/list/table/style etc.)
highlights tags with invalid names
highlights user excluded tags
emphasises document structure
distinguishes tags from document text
makes anchors easy to spot

HTML Tag and Attribute Support:

HTML 2.0 and 3.2
Netscape 2.0
Internet Explorer 2.0 and 3.0



Includes all the latest tags and attributes:

Tables and Forms
Frames
Objects, Scripts and Applets
Plug-ins
Sounds, Animations
Fonts, coloured text and so on

Target Your Pages at Chosen Browsers and Standards:

you choose to support tags by HTML standard, or browser, or both, or any combination of 
standards and browsers:

example 1: support only tags common to Internet Explorer 3.0 and Netscape 2.0
example 2: support all of HTML 3.2, plus any tags common to both Internet Explorer 2.0 and 
Netscape 2.0

in each case, Agile offers you only tags and attributes suitable for your chosen audience, and 
highlights any tags in your document which are not appropriate

Agile dynamically reconfigures its menus, dialogs, syntax colouring and status bar messages to 
support only the tags which you have chosen    

HTML Awareness Exploits Tag/Attribute Support:

Agile has built in knowledge of:

each tag and the attributes it supports
the type and values appropriate to each attribute

this knowledge is exploited to make HTML editing as quick and easy as possible by:

tag attribute editing on right-mouse-button menu
attribute descriptions and hints about values on the status bar
complete tag attribute editing properties dialog

paste URL command for instant insertion of URL's into any suitable tag
pasted URL can be from

copy or cut of selected text
using Web browser "Copy Link"
using the "Copy" command on a filename in Windows Explorer

pasted file URL's are automatically translated into relative paths

Instant Page Preview Using Web Browser:



instant display by reusing open browser and fast DDE communication
ensures browser displays the region being worked on
supports all DDE aware browsers (including Netscape and Internet Explorer, configurable for 

others)
stores multiple browser configurations
automatically starts browser if needed
reuses browser window if running

Additional User Interface Features:

simple and logical menu structure; easy to learn, fast access to any tag;
quick menu for commonly used tags
accelerators for the most frequent menu commands and tag insertions
tags inserted around selection
intelligent placement of the cursor minimises keystrokes during keyboard entry
window cascade, tile horizontal, tile vertical for easy editing of multiple documents

Works The Way You Want to Work:

upper or lower case insertion of HTML tags and attributes
configurable HTML terminology: "friendly", "official" or "raw names" on menus and dialogs
include or exclude advanced/obscure attributes from context menu
configurable editor font and text colour
configurable HTML tag colours
show/hide toolbar and status bar on or off
toolbar can float, resize, and dock at top, bottom or side





Reference
The following sections contain detailed explanations of key features, commands and parts of Agile's user 
interface.

context menu
paste URL command
editing tag attributes
keyboard commands
menus
mouse actions
dialogs
toolbar
status bar



Context Menu (Reference)
A context sensitive menu will pop up if you use the mouse to right-click on your document. Shift-F10 will 
also show the menu. The content of the menu will depend on where you right-click, or where the edit 
cursor was situated if using Shift-F10.

By right clicking on an HTML tag, you will get immediate access to a menu showing the attributes 
appropriate to the tag and help messages on the status bar indicating what they do. The menu can then 
be used to insert, remove or modify attributes very efficiently.

In some cases attribute values can be altered directly on the menu, as for the "Scrollbars" menu item in 
the example below. In other cases, the attribute values will be modified using a helper dialog which will 
vary depending on the type of value appropriate to the attribute.

 Agile's HTML awareness and ability to configure support for different HTML standards and different 
browsers, means that the context menu always shows you information about the features which you wish 
to make use of, and excludes features which you don't want.

If you click on ordinary text, 
the menu will show some 
standard text editing 
commands which can be 
used to transfer text 
between the document and 
the clipboard.

If you click on an HTML 
element, the element will be 
selected and a set of 
attribute editing commands 
will be added to the menu. 
These provide immediate 
access to individual attribute
values with helper dialogs, 
checked menu items and so 
on, according to the type of 
each attribute.

At the bottom of the menu, 
the Properties command 
opens up the Tag Attribute 
dialog for display and editing
of the attributes. This is 
more convenient for editing 
multiple attributes and 
provides additional 
assistance.

Example context menu for 
<FRAME SCROLLING=NO>:
     

Tip: If you are unsure about the meaning of one of the attribute menu items, or the values it 
accepts, highlight the item and look at the help message displayed on the status bar.



Dialogs (Reference)
Options - HTML Support Choose HTML versions and browser extensions to be supported.
Options - General Select HTML previewer, customise HTML terminology and so on.
Options - Appearance Select font and configure syntax colouring for different elements.
Element Attributes Edit a list of attributes on an HTML element.
Attribute Editing Edit the value of a single attribute.
Report Problem Generate a problem report with automatic gathering of information.
License Details Display status of your license key.
License Installation Install a license key.
File Open / Save As Load or save HTML files.
About Agile Display version and contact information.



Editing Tag Attributes (Reference)
You can edit the attributes of an HTML tag manually of course, but there are so many attributes and so 
many values that it can be a major task remembering them all. Particularly when you may be dealing with 
several versions of an HTML element each with different attributes, depending on which HTML 
specification or browser you are targeting.

Agile uses its built in HTML Awareness to combat this problem by helping you identify which attributes are
available, what they mean, and what values they accept. There are two recommended ways of editing tag
attributes:

using the context menu
using the element attributes dialog

Using The Context Menu

The context menu lists the attributes available for a chosen tag and at the bottom, has a menu item for 
opening the element attributes dialog.

To edit (or insert or remove) a tag attribute using the context menu:

1) right-click on the tag using the mouse to open the context menu

2) choose the menu item for the tag you wish to edit. (Note that as you highlight different items on the 
context menu, the status bar will change to give you a description of each attribute, and where 
appropriate, hints about the values it accepts.)

The result of executing the menu item will be one of the following:

If the chosen attribute has a fixed set of values, a pop-up menu will appear showing the available 
values (see editing attributes for more details). You can set the value or remove the attribute by choosing 
an item from the sub-menu.

If the attribute does not need a value, but is simply present or absent, choosing the item will 
"toggle" its state, either inserting it or removing it. If such an attribute is currently present in the tag, the 
context menu will indicate this by placing a check mark next to its menu item.

Otherwise, an edit attribute dialog will appear to allow you to insert, edit or remove the attribute. 
The dialog shown will vary slightly depending on the type of value appropriate to the attribute. In some 
cases, a "Browse" type button will be included to help you locate a file, but its name will reflect the type of 
file that is appropriate, and the browse dialog which it uses will also be customised to list appropriate 
kinds of file (such as HTML, images, sounds and so on).

See also using the element attributes dialog.

Using The Element Attributes Dialog

The Properties command on the context menu opens the element attributes dialog which lists all 
attributes appropriate to the current tag (and which are consistent with your chosen HTML support). 

The element attributes dialog is useful for displaying and modifying the attributes of a complex tag, and 



for changing several attributes at once.

See also using the context menu.



Keyboard Commands (Reference)
Keyboard Shortcuts to Menu Commands

Agile supports    keyboard shortcuts for inserting HTML tags, as well as the standard Windows shortcuts 
for file operations, cut and paste and so on. Shortcuts are shown to the right of their corresponding item 
on the applications menus. The supported shortcuts are listed below under the following headings:

HTML insertion and preview
edit
search and replace
file operations

Note that pressing the function key F1 accesses help related to the current context, if available. For 
example, if you have a dialog open, pressing F1 shows help about the dialog.

HTML Insertion and Preview Shortcuts

When inserting HTML using a menu command or the equivalent keyboard shortcut, the HTML tags will be
inserted at the current cursor position. If the insertion includes a start-tag and an end-tag, they will be 
inserted around the selection, if any.
      
Ctrl-B Bold tags <B></B>
Ctrl-E Image tag <IMG>
Ctrl-G Paragraph tag <P>
Ctrl-I Italic tags <I></I>
Ctrl-J List Item tag <LI>
Ctrl-K Line Break tag <BR>
Ctrl-L Anchor tag <A></A>
Ctrl-R Refresh (or start) Preview
Ctrl-1 to Ctrl-6 Insert Heading (Level 1 to 6) <H1></H1>...<H6></H6>

Tip: To set text styles quickly, first select the text and then execute the corresponding "insert tag"
command from a menu or keyboard shortcut. The start and end tags will be inserted around the 
selection. This works when inserting any start and end tag pair, and so is also useful for anchors.

Edit Shortcuts
      
Ctrl-A Select all document text
Ctrl-C Copy selection to clipboard
Ctrl-U Paste URL into tag
Ctrl-V Paste text from clipboard 
Ctrl-X Cut selection and place on clipboard
Ctrl-Y Redo last undone edit
Ctrl-Z Undo last edit

Search and Replace Shortcuts
      
Ctrl-F Find text in document
F3 Find again
Ctrl-H Find and replace



File Operation Shortcuts
      
Ctrl-N Create a new document
Ctrl-O Open document file
Ctrl-S Save current document



Menus (Reference)
The main menu contains the following sub-menus, each of which is described in more detail later.

File File open, save and so on, opening of recently used files. Access to configuration options.
Edit Multi-level undo/redo, cut, copy, paste (of text and URLs), and search and replace.
Quick Access to the most used HTML tags and HTML previewer.
Structure Structural elements such as frames, headings, text layout, lists and text block elements.
Formatting Text formatting HTML elements for explicit text styles and also for formatting by content.
Advanced Advanced features including tables, forms, maps, sounds, objects, applets and so on.
Window Standard window menu including arrangement commands and list of open documents.
Help Access to help, problem reporting and Agile license details and installation.

The Quick, Structure, Formatting and Advanced menus are automatically configured by Agile to support 
only the features you specify using HTML Support Options, avoiding clutter from unwanted features. As a 
result, it impractical to document the items on these menus individually, but this is offset by the fact that 
every menu item is explained on the status bar as you highlight it on the menu.

File Menu

New Create new empty document
Open Open HTML document
Close Close the active document
Save Save the active document
Save As Save the active document under a new name

Options Options dialog for configuring syntax colouring, HTML support
and miscellaneous features

Recent Files List of names for opening recently edited files

Exit Exit Agile and offer to save any unsaved changes

Edit Menu

Undo Undo last edit (multi-level)
Redo Redo last undone edit (multi-level)

Cut Remove the selection and place on the clipboard
Copy Copy the selection and place on the clipboard
Paste Replace the selection with text from the clipboard
Paste URL Insert a URL from the clipboard into a tag
Select All Selects all the text in the document

Find Find text within the document
Find Next Find the next (or previous) occurrence of some text
Replace Find and replace document text

Quick Menu



The Quick menu inserts frequently used tags:

Refresh Preview Refresh the document preview (starting a browser if needed)
Hypertext Link Insert tags around the selection to create an anchor: 

<A></A>
Image Insert an embed image tag: <IMG>
Image Link Insert anchor tags around an image tag: <A><IMG></A>
List Item Insert a list item tag: <LI>

Bold Insert bold text style tags: <B></B>
Italic Insert italic text style tags: <I></I>
Underline Insert underlined text style tags: <U></U>

Paragraph Insert a start paragraph tag:<P>
Line Break Insert a line break tag: <BR>
Horizontal Rule Insert a horizontal rule tag: <HR>

HTML 3.2 Document Insert a simple template for an HTML 3.2 (or other) document

The above menu is constructed automatically based on your chosen HTML support configuration. Most 
tags that can feature on the quick menu are supported by most useful configurations, so it makes sense 
to describe them in full:

Note that HTML menu item names are configurable using the general options dialog. The above names 
are as shown with "Descriptive" HTML terminology.

Structure Menu

The Structure menu contains items and submenus for inserting structural HTML tags including:

head elements such as title, base URL and meta information
headings (level 1 to 6)
text layout such as paragraphs and line breaks
text blocks such as preformatted, listing and example
lists, ordered, unordered and definition lists
frames

The above Structure menu is constructed automatically to insert tags from your chosen HTML support 
configuration. This means that it is not practical to document the individual items, and so a summary of 
the HTML tag types has been provided instead.

Note that HTML menu item names are configurable using the general options dialog. The above names 
are as shown with "Descriptive" HTML terminology.

Formatting Menu

The formatting menu contains items and submenus for inserting text formatting tags including:

typographical styles such as bold, italic and strikeout



fonts both preset (small, large, subscript and so on) and general such as the font tag
content such as citation, source code, example, emphasis and so on

The above Formatting menu is constructed automatically to insert tags from your chosen HTML support 
configuration. This means that it is not practical to document the individual items, and so a summary of 
the HTML tag types has been provided instead.

Note that HTML menu item names are configurable using the general options dialog. The above names 
are as shown with "Descriptive" HTML terminology.

Advanced Menu

The items in the advanced menu depend more than any other on your HTML support configuration, since 
it covers many of the most recently introduced and least widely supported features of HTML.

These advanced HTML elements include:

tables
objects and embedded components including scripts, sounds, marquees and so on
forms
image maps

The above Advanced menu is constructed automatically to insert tags from your chosen HTML support 
configuration. This means that it is not practical to document the individual items, and so a summary of 
the HTML tag types has been provided instead.

Note that HTML menu item names are configurable using the general options dialog. The above names 
are as shown with "Descriptive" HTML terminology.

Window Menu

Cascade Arrange open document windows in overlapping cascade
Tile Horizontally Arrange open document windows tiled above one another
Tile Vertically Arrange open document windows tiled side by side
Arrange Icons Arrange minimised document windows

Toolbar Show or hide the toolbar
Status Bar Show or hide the status bar

Document Windows List of open documents for activation

Help Menu

Help Topics Open Agile help and show help topics
Report Problem Open a dialog for generating a problem report file

How To Register Shows help about registering Agile
License Details Display current license status
Install License Install a license key



About Agile Displays version and contact information



Mouse Actions (Reference)
In addition to the usual mouse actions, Agile supports the following extra features:

right click tag editing
drag and drop text editing
left margin line selection

Right Click Tag Editing

When you click on a tag with the right mouse button, the whole HTML element becomes selected and a 
context sensitive menu will appear, with menu items customised for the selected element.

The context sensitive menu shows the attributes appropriate to the tag using your chosen settings for 
HTML Support. The menu also reflects the values of any attributes present in the tag, and can be used to 
open the element attributes dialog.

 See Context menu for details.

Drag And Drop Text Editing

If you drag text using the mouse, you can insert it at another point in the document, or in another Agile 
document, or even in another application (so long as the other application supports drag and drop 
editing).

Dragged text will either be moved or copied to the new location depending on whether or not you hold 
down the Ctrl key at the start of the drag:

to move text, just drag the selected text;
to copy text, hold down the control key when starting to drag selected text.

You can also drop text into Agile from another drag and drop editing application. For example, you can 
drag a URL from Netscape Navigator or Internet Explorer and drop it into an Agile document by dragging 
the Hypertext Link from the browser. Note though, that handling URL's is a speciality of Agile, so you 
should also read about the Paste URL command.

Left Margin Line Selection

You can select an entire line of text by clicking with the mouse in the left margin of a document.

If you hold the mouse button down you can select multiple lines using the left margin.





Paste URL command (Reference)
The Paste URL command [Ctrl-U] is a quick way of setting the value of a URL attribute in a tag. It works 
for any suitable HTML element including anchors <A></A>, images <IMG>, frames <FRAME> and so 
on. Select it from the Edit menu, the Context menu, or using the keyboard shortcut Ctrl-U.

There is more to this extremely useful command than meets the eye, so it is well worth reading the 
following description in full.

how to paste a URL
automatic translation to URL format
automatic conversion to relative paths

How to Paste a URL

To use this command, first ensure that a file name, path or URL is stored on the clipboard, which can be 
done in one of the following ways:

select some text within Agile and do Edit, Copy [Ctrl-C] (this works in most Windows 
applications); or

select a single file within Windows Explorer and do Edit, Copy [Ctrl-C]; or
within Netscape Navigatorr, right click on a link and choose "Copy this Link Location"; or
within Internet Explorer, right click on a link and choose "Copy Shortcut".

Having placed a URL on the clipboard, you are ready to paste it into a tag. This can be done using the 
Paste URL command on either the Edit menu or the Context menu or using the keyboard shortcut Ctrl-U.

To insert the URL, you must position the carat on the start or end tag of a suitable HTML element, or 
when using the Context menu, right click with the mouse on the start or end tag. Then execute the 
command using the menu item or by typing Ctrl-U.

Important Notes:

There is no need for the URL attribute to be present in the tag, or for you to position the carat on such an 
attribute. Anywhere in the start or end tag will do.

The chosen tag will have its URL attribute value set to the value present on the clipboard. If the tag is an 
anchor, the HREF attribute will be set, if it is an Image, the SRC attribute will be set, and so on. Agile 
understands which attributes accept URLs and will decide which to set or insert. If the tag does not have 
an attribute which can accept a URL, the command will be disabled.

Agile recognises URLs and understands the format required in HTML tags. It uses this knowledge to try 
and ensure that the most appropriate value is inserted into the tag. Some examples are included below.

Automatic Translation to URL Format

Absolute file paths are translated into URL paths, for example, pasting

c:\html\index.htm
into

<A></A>



would produce
<A HREF="file:///c|/html/index.htm"></A>

Automatic Conversion to Relative Paths

To ensure that file URLs remain valid when your pages are uploaded onto a Web server, absolute paths 
are automatically translated into relative paths, assuming a relative path is available. For example, 
pasting

c:\LocalWeb\Graphics\bullet.gif

into an anchor tag contained in the document c:\LocalWeb\Sports\Football\Liverpool.htm would produce

<IMG SRC="..\..\graphics\bullet.gif">

This helps minimise the amount of work which you need to do to ensure that your pages will work when 
uploaded onto your Web server.





Status Bar (Reference)
The Status Bar is an optional part of the main Agile window, which can be shown or hidden using the 
Window menu.

The left side of the Status Bar is used to display status messages and helpful hints, depending on what 
you are doing. On the right, CAP, NUM and SCROLL will be displayed to indicate lock for each of Caps 
Lock, Num Lock and Scroll Lock keys respectively.

 Click on the picture where you see this cursor.

The default status message is "For Help, press F1" as a reminder that pressing F1 will take you to help 
relevant to the current context. This is a neat way of getting help about the settings of an open dialog.

When you have a menu open, the status message changes to provide a summary of the currently 
highlighted menu item. This is particularly useful as a reminder of the function of HTML element attributes,
which are displayed as menu items on the Context menu.



Toolbar (Reference)
The Toolbar is an optional part of the main Agile window, which can be shown or hidden using the 
Window menu.

The following picture shows part of the Agile application window including the Toolbar docked at the top of
the Agile main window. Click on the picture for an explanation of the different toolbar buttons.

Using the mouse you can drag the toolbar to the left or right, and also undock it by dragging it away from 
the edge of the main window. The undocked, or floating, toolbar can be resized by dragging its corners 
using the mouse.

You can dock the toolbar by dragging it near the top, bottom, left or right edges of the main window. If you
want to prevent docking, hold the Ctrl key down while dragging the toolbar with the mouse.

 Click on the picture where you see this cursor.



Remove the attribute from the tag.



Set the attribute value.



Insert bold tags around the selection



Copy selection to clipboard



Create a new document



Cut selection and place on clipboard



Find text within document



Show information about Agile



Show help on next action



Hide toolbar



Insert anchor tags around the selection



Insert list item tag in front of the selection



Insert italic tags around the selection



Create new document



Toolbar - open document



Open document



Paste clipboard text into the selection



Print document



Refresh preview



Save document



This is a floating toolbar containing buttons for frequently used commands.

You can move the toolbar around and resize it using the mouse.

If you drag it near the top, bottom, left or right edges of the main Agile window, it will dock with the window
(unless you keep the Ctrl key held down to prevent docking).



WYSIWYG stands for "What You See Is What You Get" and means that while being edited, the document 
attempts to appear as it will when published on the Web.

For HTML and the Web, WYSIWYG is a myth because the philosophy and the reality of the Web is that 
different browsers present the same page differently, and the user can even configure the way their 
browser presents information. In addition, there is still no accepted standard definition of HTML, so not 
only do different browsers interpret tags differently, but they frequently lack support for different tags, or 
tag attributes. This situation is likely to continue for the foreseeable future, so while WYSIWYG can make 
editing easier, it makes it very difficult to produce high quality pages, which load efficiently, and which will 
work with different browsers.



A Web Browser is an application for accessing the World Wide Web.

Browsers such as Internet Explorer and Netscape Navigator have a very rich set of features including 
support for graphics, animation and sounds, but there are also much simpler browsers, some of which 
operate using a simple character based display.



The World Wide Web is a virtual document made up of countless HTML files spread across countless 
computers around the world.

This document can be displayed using a Web Browser and used to access disparate parts of the Web in 
a seamless manner.



A Keyboard Shortcut is a combination of key-presses which can be used as a quick way of carrying out 
an operation normally done by invoking a menu item.




